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About This Guide

This framework was created by Region 10 Education Service Center (ESC) to help
educational organizations navigate the transformative potential of artificial intelligence.
Rooted in our mission to serve the learning community with responsive, innovative
solutions, this guide reflects a collaborative effort to address challenges and build
sustainable AI initiatives.

Guided by our motto—Students • Service • Solutions—the framework empowers
educators, students, and leaders to foster innovation and equity across diverse
contexts.

This resource includes linked materials from various sources, which are not owned by
Region 10 ESC nor claimed as proprietary.

How to Use This Document

This guide provides a flexible framework to help organizations implement AI initiatives in
education. It is not a step-by-step manual but a resource to be customized based on
your unique goals, needs, and resources.

Key Features:

● Adaptable Framework: Adjust steps and priorities as needed to fit your
organization’s context.

● Collaborative Tool: Share this guide with teams and stakeholders to foster
alignment and engagement.

● Scalable Approach: Start with feasible steps and scale as your capacity grows.
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Comment to Provide Feedback

This is a working document. Use the "Insert > Comment" feature to share feedback,
suggestions, or questions directly in the document. Your input helps us improve and
adapt this resource to meet your needs.

Download or Copy this Document

If you would like your own copy to edit:
1. Download the file: Go to File > Download.
2. Copy the document: Sign into Google and go to File > Make a Copy.

Challenges Addressed by This Framework

This framework addresses common challenges faced during AI integration, ensuring
sustainable and impactful implementation:

1. Lack of Clear Direction for AI Integration
2. Navigating and Staying Up-to-Date on Overwhelming Resources and Information
3. Capacity Constraints
4. Scalability and Sustainability Concerns
5. Lack of Dedicated AI Support
6. Outdated Professional Development Models
7. Knowledge Gaps
8. Resistance to Change and Limited Buy-In
9. Engaging Stakeholders in Meaningful Ways
10. Outdated Educational Practices
11. Lack of Measurable Outcomes
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From Challenges to Action: Phases and Steps

This framework provides a clear pathway divided into four phases—Build Foundation, AI
Integration, AI Innovation, and Reflect and Adjust—each with actionable steps
designed to guide your organization.

The goal is to build a strong foundation before progressing to implementation and
long-term innovation. The steps are flexible and can be revisited, reordered, or adapted
to suit your organization’s specific needs and circumstances.

AI integration is a multifaceted process. While resources may vary between
organizations, collaboration, shared ownership, and capacity-building are key to
creating sustainable, forward-thinking strategies that align with your goals.
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🌱 Phase 1: Build Foundation

Step 1: Assess Readiness

Objective Evaluate organizational strengths, gaps, and opportunities to support AI integration.

Actions to
Consider

Conduct a self-assessment using the K-12 Generative AI Readiness Checklist to
identify strengths, gaps, and opportunities.
Analyze results to understand current resources, infrastructure, and policies.
Summarize findings to inform the next steps in capacity-building and planning.
➡ Use K-12 Generative AI Maturity Tool as a guide for refining priorities.

Outcome Insights into readiness that shape the roadmap for AI integration.

Step 2: Build Cross-Functional Teams

Objective Develop a structured approach to align internal teams with AI initiatives and engage
external stakeholders for support.

Actions to
Consider

Actions to Consider:

Evaluate Organizational Structure:

Identify existing departments or teams that can support AI efforts (e.g., IT for
technical guidance, curriculum for instructional integration).
Map roles and responsibilities within current teams to align with AI needs.

Define Roles and Responsibilities:

Assign specific roles based on expertise and organizational needs.
Ensure accountability by clarifying how each role contributes to AI integration.
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Engage External Stakeholders:

Partner with educators, students, board members, parents, businesses, and higher
education institutions to provide additional expertise and resources.
Include external advisors in strategy sessions or feedback loops to ensure broader
alignment with community and district goals.

Outcome A well-defined internal structure and team roles complemented by external partnerships,
creating a collaborative foundation for AI integration.

Step 3: Strategic Planning

Objective Create a unified, actionable AI integration plan that outlines how the organization will
maximize its internal capacity, stay current with emerging trends, and provide support to
external schools and districts.

Actions to
Consider

Build a Comprehensive Roadmap that includes your organization's AI policy:
Outline goals, timelines, and milestones to guide AI integration.
Embed Metrics: Define measurable outcomes to track progress and evaluate
success.
Data and Metrics: Identify metrics to measure progress and evaluate the impact
of AI integration.
Include Feedback Loops: Establish mechanisms to gather input from stakeholders
and refine the plan continuously.

Outcome A clear, adaptable roadmap that ensures progress, accountability, and scalability.

CONTINUE TO PHASE 2

------------------------------------⬇------------------------------------
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🔄 Phase 2: AI Integration

Step 4: Curate and Share Resources

Objective Establish a centralized hub for AI resources, offering quick wins and ensuring stakeholders
have easy access to tools, guidance, and ongoing professional development
opportunities.

Actions to
Consider

Compile Resources:

Gather free, high-quality AI tools, guides, and case studies tailored to educators,
administrators, and support staff.
Include curated lists of AI applications for various use cases, such as lesson
planning, data analysis, and administrative tasks.

Design the Hub:

Build the hub on an accessible platform, such as a dedicated website, shared
Google Drive, or learning management system.
Ensure the hub is user-friendly with clear navigation and search functionality for
ease of access.

Expand Over Time:

Continuously add professional development materials, such as webinars, tutorials,
and certification programs.
Include links to external learning opportunities, such as state-level initiatives or
university programs.

Incorporate Feedback:

Implement a feedback mechanism (e.g., surveys or a suggestion form) to identify
resource gaps and refine the hub’s content.

Promote Usage:
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Share the hub widely with stakeholders through newsletters, social media, and
workshops.
Host introductory sessions to demonstrate how to navigate and use the hub
effectively.

Outcome A dynamic and accessible AI resource hub that empowers stakeholders to implement AI
tools and strategies effectively while fostering ongoing learning and collaboration..

Step 5: Create a Professional Development Plan

Objective Create a tiered training program that equips leaders, educators, and staff with the skills,
tools, and strategies needed to integrate AI effectively while advancing digital equity
and powerful learning. This step draws inspiration from the Digital Promise Equity
Framework to ensure all professional development prioritizes equitable access and
transformative learning.

Actions to
Consider

Internal Training: Preparing for Success:

Develop an internal professional development (PD) plan to build capacity among
leadership and key staff who will champion AI integration.

Internal PD Plan aligned with External Tiers: Develop a structured training program
tailored to departmental roles and focused on AI literacy, ensuring staff
understand foundational AI concepts and applications.
Foster a Learning Culture: Encourage ongoing professional growth by supporting
staff attendance at conferences, completion of certifications, and participation
in online AI courses.
Create Internal AI Champions: Identify and train internal staff with expertise to act
as AI mentors, providing support both within the organization and to external
stakeholders.
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External Support and Professional Development Plan

Tier 1: Leadership Support: Focus on policies, resources, and technology systems to
create equitable and sustainable AI integration.

Systems and Policies: Develop policies that support ethical AI use, privacy, and
equity. This section draws on insights from the TeachAI Toolkit, a valuable resource
for crafting ethical and effective AI policies in education. Note: Start by revising
your current policies.
This is a great example of how Gwinnett County Public schools used the policy the
TeachAI Toolkit to create asn share their AI Approach.
Infrastructure: Ensure consistent access to devices, connectivity, and support
systems to enable reliable AI adoption.
Resources: Train leaders on managing AI tools in alignment with organizational
goals and digital equity.

Tier 2: Digital Literacy for Educators: Foster AI literacy and enhance instructional
practices by equipping educators with the knowledge and tools needed to
effectively integrate AI into their work. Inspired by Digital Promise's AI Literacy
Framework, this tier emphasizes understanding, evaluation, and practical application
of AI in education.

Level 1: Understanding AI (AI Literacy)
Build foundational knowledge of AI concepts, ethical considerations, and
the technology's potential impacts on teaching and learning.
Train educators to evaluate AI tools critically, understanding both
opportunities and limitations.

Level 2: AI for Productivity and Efficiency
Introduce tools that simplify administrative tasks, personalize instruction, and
streamline workflows.

Level 3: Pedagogical Integration
Support educators in embedding AI tools into teaching strategies to
enhance engagement, enable differentiation, and improve outcomes.
Emphasize culturally responsive and equitable practices in AI integration,
ensuring all students benefit from the technology.
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Tier 3: Curriculum Support for Powerful Learning: Empower curriculum teams to
integrate AI into transformative learning experiences.

Use AI to drive Powerful Learning, emphasizing collaboration, critical thinking, and
problem-solving through technology.
Support curriculum development that aligns with AI-enhanced tools and
methodologies.
Ensure AI integration prioritizes equitable access and culturally responsive
practices.

Tier 4: Ecosystem Expansion (Conferences and Partnerships): Expand AI’s impact
through collaboration and professional networks.

Conferences: Host events to showcase best practices, innovations, and success
stories in AI adoption.
Partnerships: Collaborate with universities, tech companies, and community
organizations to provide advanced resources, tools, and training opportunities.

Additional Considerations:

Customize Delivery Options: Provide diverse training formats to meet varying needs,
including:

Online courses, in-person workshops, live webinars, and self-paced modules.
Micro-credentials to validate learning and encourage professional growth.
Collaborative resources like book studies, professional learning communities, and
mentorship opportunities.

Foster Learning Communities:

Establish learning communities that promote collaboration, sharing, connecting,
and continuous improvement in AI implementation.

Outcome A well-defined internal structure and team roles complemented by external partnerships,
creating a collaborative foundation for AI integration.
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Step 6: Empower Educators as AI Ambassadors

Objective Foster a community-driven model where educators take the lead in driving AI integration
efforts within their schools and communities.

Actions to
Consider

Identify and Train AI Ambassadors:

Select educators passionate about technology and innovation to become AI
Ambassadors.
Provide specialized training in AI tools, integration strategies, and presentation skills
to prepare them for leadership roles.

Facilitate Educator-Led Initiatives:

Support Ambassadors in leading webinars, hosting workshops, and organizing
community events to share AI best practices.
Encourage peer-to-peer learning by having Ambassadors mentor other educators
in their districts.

Establish a Recognition Program:

Award certifications or digital badges to educators completing Ambassador
training to acknowledge their expertise and leadership.
Highlight their contributions through newsletters, social media, and organizational
events.

Host an Annual Ambassador Showcase:

Organize a showcase event where AI Ambassadors present their success stories,
innovations, and lessons learned.
Include panels, demonstrations, and Q&A sessions to inspire others to adopt AI
practices.

Provide Continuous Support:

© 2024 by 12



Maintain a support network for Ambassadors, such as access to advanced
training, exclusive resources, or a dedicated online community for collaboration.

Outcome A vibrant, peer-led movement where educators champion AI adoption, foster
innovation, and create a ripple effect of expertise and enthusiasm across schools and
communities.

CONTINUE TO PHASE 3

------------------------------------⬇------------------------------------

💡 Phase 3: AI Innovation

Step 7: Engage Students as Leaders

Objective Empower students to take active roles in shaping how AI is used in education, fostering
leadership skills and technical proficiency.

Actions to
Consider

Actions:

Establish a Student AI Advisory Council:

Form a council of diverse student representatives to provide input on AI projects
and initiatives within their schools and communities.
Include responsibilities such as evaluating AI tools, proposing innovative uses, and
advocating for ethical AI practices.

Create Peer Mentorship Programs:

Train students with strong AI skills to mentor peers, introducing them to AI
concepts, tools, and applications.
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Pair students with educators or industry professionals to gain real-world experience
and guidance.

Integrate Students into AI Projects:

Involve students in AI-related initiatives, such as developing tools for classroom
use, managing data projects, or participating in coding challenges.
Showcase student-led AI innovations during school or district events to celebrate
their achievements.

Connect AI Leadership to Careers:

Partner with CTE programs and local businesses to expose students to AI-related
career pathways.
Facilitate internships or externships where students can apply their skills in
professional settings.

Outcome A generation of students skilled in AI, prepared to lead in their communities.

Step 8: Rethink Outdated Teaching and Learning Practices

Objective Challenge traditional models of education by leveraging AI to transform teaching and
learning into dynamic, student-centered experiences that prioritize creativity,
collaboration, and critical thinking over rote memorization and one-size-fits-all
approaches.
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Actions to
Consider

Shift from Standardization to Personalization:

Replace rigid, one-size-fits-all curriculums with AI tools that create adaptive,
individualized learning experiences.
Move beyond standardized testing to measure student growth through AI-driven
formative assessments and portfolio-based evaluations.

Reimagine Learning Environments:

Shift from traditional, lecture-based classrooms to dynamic, student-driven spaces
where AI supports personalized and collaborative learning experiences.
Create flexible, tech-enabled environments that foster exploration,
experimentation, and hands-on problem-solving.
Integrate AI tools into physical and virtual learning spaces to enhance
engagement, adaptability, and access to global resources.

Foster Lifelong, Inquiry-Based Learning:

Shift focus from memorization to inquiry, with students using AI to ask questions,
analyze data, and generate solutions to real-world problems.
Create project-based, interdisciplinary learning experiences that reflect how AI
impacts industries outside the classroom.

Integrate Authentic, Real-World Applications:

Collaborate with local businesses, government agencies, or universities to bring
AI-driven challenges into classrooms.
Use AI to simulate real-world environments, such as virtual labs or interactive
history experiences, making learning immersive and relevant.

Promote Equity and Accessibility:

Use AI to identify and address learning gaps, ensuring all students have equitable
access to resources and opportunities.
Focus on culturally responsive AI applications that represent diverse perspectives
and needs.
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Outcome Students develop critical, creative, and future-ready skills through personalized learning,
interdisciplinary projects, and active engagement with AI as a tool for creation and
problem-solving.

Step 9: Foster Future Innovation

Objective The future of AI in education is a landscape yet to be fully realized. This step embraces
the unknown, encouraging exploration, experimentation, and forward-thinking
approaches to shape what’s next

Actions to
Consider

Innovation requires a willingness to step into uncharted territory. As AI evolves, so too will
its applications in education. While we can envision possibilities—interdisciplinary
projects, cutting-edge tools, and student-driven solutions—the true potential is still
emerging. This phase invites educators, students, and stakeholders to dream boldly,
explore collaboratively, and remain adaptable as new opportunities arise.

Outcome A mindset of curiosity and openness that fosters a culture of exploration, ensuring
education remains at the forefront of innovation as AI continues to transform the world.

CONTINUE TO PHASE 4

------------------------------------⬇------------------------------------

📊 Phase 4: Reflect and Adjust

Step 10: Collect Data

Objective Gather actionable insights to measure progress and guide decisions.
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Actions to
Consider

Use surveys, analytics, and performance metrics to evaluate the impact of AI
initiatives on teaching, learning, and operations.
Create a Data Dashboard to compile and visualize findings for easy access and
transparent reporting.

Outcome A clear understanding of successes, challenges, and areas for improvement in AI
initiatives.

Step 11: Adjust Based on Insights

Objective Refine strategies to meet evolving needs and challenges.

Actions to
Consider

Host quarterly feedback forums with stakeholders.
Use agile planning to update goals and action plans.

Outcome A flexible and adaptive strategy that aligns with the organization’s evolving needs and
ensures continuous improvement.

Step 12: Communicate Outcomes

Objective Share progress, successes, challenges, and next steps with stakeholders to build
transparency and momentum.

Actions to
Consider

Publish newsletters, case studies, and reports to highlight achievements and
lessons learned.

© 2024 by 17



Host annual conferences or showcases to celebrate progress, share innovations,
and inspire further engagement.

Outcome Broad awareness, trust, and buy-in for the organization’s ongoing AI initiatives, fostering a
collaborative and supportive environment.

Conclusion

This framework serves as a guide to help organizations navigate the complexities of AI
integration in education, addressing key challenges while fostering innovation,
collaboration, and sustainability. By progressing through the phases and steps, you can
build a strong foundation, implement impactful AI strategies, and continually adapt to
emerging trends and needs. While the framework provides a structured approach, its
flexibility allows for customization to meet your unique context and goals. The ultimate
vision is to empower educators, students, and leaders to harness AI’s potential, creating
a forward-thinking, equitable, and innovative educational ecosystem that prepares all
stakeholders for the future.
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Terms and Conditions
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for the original purchaser or licensee to use and reproduce portions of this template
specifically for educator use. You may not claim ownership of this material, alter the
original files, or remove any copyright notices. This product may not be sold or
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